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Goal of Atomistic Simulations 
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Understanding on 
the level of electrons 

and atoms 

Prediction of 
materials properties of 

engineering value 

MedeA®: Software for Efficient R&D   
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Materials Design, Inc. Company Profile 

  Founded by scientists in 1998 

Over 400 customers in industry, universities, and government 
laboratories including over 50 major companies worldwide 

  Products: MedeA® software, support, and consulting services 

Global: Offices in San Diego, Angel Fire, Paris, and Stockholm 

Business partners: Japan, Korea, China, Taiwan, Singapore, and India  

Core competence in 
•  Computational chemistry & physics 
•  Materials science & chemical engineering  
•  Materials property databases & software engineering  

 Company Profile 
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Products and Services 

MedeA® software 
•  Comprehensive atomistic modeling environment with leading technology 
•  Installation, training, online support, and maintenance 
•  Scientific/technological interactions 
•  Users group meetings 

  Contract research 
•  Solution of specific industrial problems 
•  Leverages expertise and resources of MD’s scientists 
•  Publicly funded programs 

  Technology partnerships 
•  Development of customized modeling capabilities (e.g. Toyota) 
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Materials Exploration and Design 
Analysis 
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 MedeA® Software 
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ICSD NIST Crystal Data Computed 

C O M P U T A T I O N   O F   P R O P E R T I E S 

Experimental and Computed Structure and Property Data 

ab initio QM - VASP 

Mechanical        Thermal        Chemical        Kinetic        Electric        Optic        Magnetic 

D A T A B A S E S 

M O D E L I N G   &   A N A L Y S I S 

Pearson Pauling 

Monte Carlo - GIBBS Mol. dynamics - LAMMPS 

Job Server 

Task Servers 

Builders: crystals, defects, interfaces, surfaces, 
molecules, nanostructures, polymers, amorphous 

materials 

Analysis: geometry, band structures  and DOS, 
electron and spin density, potential, Fermi surface, 
phonons, transition states, dynamics trajectories 

Semi-empirical - MOPAC 
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MedeA® Components 

  MedeA®-Environment 
•  Model builders 
•  Database infrastructure 
•  Analysis tools 
•  Flowcharts 
•  JobServer/TaskServer 

InfoMaticA  
•  About 500,000 database entries combining ICSD, 

Pearson, Pauling, NIST Crystal Data, COD 
•  Computed data 

  VASP 
•  GGA , post-DFT (hybrid, sX, GW, RPA) 
•  H to Cm PAW potentials (all electron) 
•  Spin-orbit relativistic 
•  Linear response 

  LAMMPS 
•  Forcefields including pcff+, ionic, EAM 

  GIBBS 
•  Adsorption 
•  Fluid phase equilibria 

  MOPAC 
•  Semi-empirical QM, PM7 
•  Thermodynamics, IR, UV-vis 

© Materials Design, Inc. 2015 

Property Packages 

  Mechanical-Thermal (MT) 
  Phonon 

•  Phonon dispersions 
•  Vibrational properties 
•  Thermodynamic functions 

  Electronics 
•  Effective masses 
•  Boltzmann transport 
•  Electrical/thermal conductivity 
•  Thermoelectricity 

  Transport 
•  Diffusion 
•  Thermal conductivity 
•  Viscosity 

  Transition State (TSS) 
  Amorphous materials 
  Polymer properties 

•  QSPR 

PrediBondTM – catalysis 
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Ab Initio Methods 

  

INPUT 
  Arbitrary position 

of atomic nuclei 
  Atomic numbers 
  Atomic masses 

 

 
mass and charge of an electron 

Planck’s constant  
Speed of light  

	
  

Computer programs1 

 
 

Schrödinger’s equation 
Many-body theory2	
  

 
	
  

OUTPUT 
  Interatomic distances 
  Lattice parameters 
  Stress 
  Thermodynamic stability  
  Defect energies 
  Surface energies 
  Grain boundary energies 
  Adsorption energies 
  Binding energies of impurities 
  Reaction barriers 
  Diffusion rates 
  Electronic, optic, and magnetic 

properties 
  … 

 

1.  Vienna Ab initio Simulation Package (VASP) 
2.  Density functional theory (DFT) 

•  free of system-specific parameters 
•  general and high predictive power 
•  few hundred atoms per simulation box 
•  very short time scales (pico-seconds) 
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Forcefield Methods 

  

INPUT 
  Arbitrary position 

of atomic nuclei 
  Atom types 
  Atomic masses 
  Parameters for 

interatomic 
interactions 

 

Computer programs1 

 
 

Newton’s equation of motion 
 
	
  

OUTPUT 
  Interatomic distances 
  Lattice parameters 
  Stress 
  Thermodynamic stability  
  Defect energies 
  Dislocations 
  Surface energies 
  Grain boundary energies 
  Diffusion rates 
  … 

 

1.  Large-scale Atomic/Molecular Massively Parallel Simulator 
(LAMMPS) 

•  system-specific parameters fitted to ab initio 
or experimental data (MedeA®-FFO) 

•  predictive within range of fitting parameters 

•  up to millions of atoms per simulation box  

•  time scales into the nano-seconds  

•  no electronic structure-related properties 
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Flowcharts 
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Electronic Properties, Band Gaps 
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 Accurate Band Structures 

Note: Standard LDA or GGA predicts Ge to be metallic 
© Materials Design, Inc. 2015 15 



 Accuracy of Computed Band Gaps 
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Performance of VASP 5.2 as reviewed by 
J. Hafner, J. Phys.: Cond. Matter 22, 384205 (2010) 
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Germanium: Atomic Structure 

•  cubic, space group Fd-3m 
•  acomp = 5.671 Å  
•  aexp ≈ 5.658 Å (Ioffe) 
•  aexp ≈ 5.715 Å (InfoMaticA ave) 

Calculational parameters 
•  MedeA®-VASP 5.3 
•  PBEsol functional, spin-orbit relativistic 
•  standard 500 precision, reciprocal-space projection 
•  Δk ≈ 0.2/Å, 11×11×11 k-points, Γ-centered  

© Materials Design, Inc. 2015 17 

Ioffe: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/  



Germanium: Electronic Structure 
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Exp. data: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/  
                 Handbook on Physical Properties of Semiconductors,  
                 Vol. 2, ed. S. Adachi (Kluwer, Boston 2004) 
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Source	
   a	
  (Å)	
   Gap	
  (eV)	
  

mBJLDA	
   5.658	
   0.72	
  

mBJLDA	
   5.671	
   0.70	
  

Ioffe	
   5.658	
  (300K)	
   0.66	
  (300K)	
  

Ioffe	
   0.74	
  (0K)	
  

Calculational parameters 
•  MedeA®-VASP 5.3 
•  mBJLDA functional, spin-orbit relativistic 
•  normal precision, default plane-wave cutoff 
•  reciprocal-space projection, linear tetrahedron method 
•  Δk ≈ 0.2/Å, 11×11×11 k-points, Γ-centered  



Germanium: Electronic Structure 
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Exp. data: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/ 

MedeA®-VASP 
•  computed band energies in good agreement with 

experimental data 
•  temperature effects (thermal expansion, phonons) 

may change the band structure  

 

 

  

Exp.	
   mBJLDA	
  
(5.658)	
  

mBJLDA	
  
(5.671)	
  

Eg	
   0.66	
   0.72	
   0.70	
  

ΔE	
   0.85	
   0.95	
   0.98	
  

EX	
   1.12	
   1.15	
   1.15	
  

ESO	
   0.29	
   0.27	
   0.27	
  

EΓ1	
   0.8	
   0.80	
   0.74	
  

EΓ2	
   3.22	
   2.78	
   2.78	
  



Germanium: Effective Masses 
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MedeA®-Electronics 
•  computed effective masses in good 

agreement with experimental data  
•  heavy hole mass beyond parabolic 

approximation 

 

 

  

Exp.	
   MedeA	
  

Electrons	
  

Long.	
  Eff.	
  Mass	
   1.59	
   1.77	
  

Trans.	
  Eff.	
  Mass	
   0.081	
   0.096	
  

DOS	
  Mass	
   0.22	
   0.64	
  

Conduc8vity	
  Mass	
   0.12	
   0.14	
  

Heavy	
  Hole	
  

Eff.	
  Mass	
   0.33	
   0.080	
  

Light	
  Hole	
  

Eff.	
  Mass	
   0.043	
   0.085	
  

Split-­‐off	
  band	
  	
  

Eff.	
  Mass	
   0.084	
   0.112	
  

Exp.: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/ 



MedeA®-Electronics 
•  directional effective masses 

in reasonable agreement 
with k�p results 

  

Germanium: Effective Masses 
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Heavy Hole Light Hole 
Exp. k.p calc Exp. k.p calc 

<001> 0.284 0.209 0.111 0.044 0.0459 0.066 

<111> 0.376 0.503 0.561 0.043 0.0407 0.0455 

Directional effective masses: 

S. Ben Radhia et al., J. Appl. Phys. 92, 4422 (2002) 



Si1-xGex: Atomic Structure 

•  2×2×2 supercell of diamond 
•  replace x×64 Si atoms by Ge  
•  cubic, space group P1 
•  relax structure  

Calculational parameters 
•  MedeA®-VASP 5.3 
•  PBEsol functional 
•  normal precision, real-space projection 
•  Δk ≈ 0.2/Å, 3×3×3 k-points, Γ-centered  

© Materials Design, Inc. 2015 22 



Si1-xGex: Electronic Structure 

Calculational parameters 
•  MedeA®-VASP 5.3 
•  mBJLDA functional 
•  normal precision, real-space projection 
•  Δk ≈ 0.2/Å, 3×3×3 k-points, Γ-centered  

© Materials Design, Inc. 2015 23 

Ioffe: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/  

•  calculations give band gap 
trend in close agreement 
with experimental data 

•  band gap variation due to 
disorder ≈ 0.05 eV  

•  band gap is slightly over-
estimated   



GaAs: Atomic Structure 

•  cubic, space group F-43m 
•  acomp = 5.671 Å  
•  aexp ≈ 5.65325 Å (Ioffe) 
•  aexp ≈ 5.6477 Å (InfoMaticA ave) 

Calculational parameters: 
•  MedeA®-VASP 5.3 
•  PBEsol functional, spin-orbit relativistic 
•  standard 500 precision, reciprocal-space projection 
•  Δk ≈ 0.2/Å, 11×11×11 k-points, Γ-centered  
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GaAs: Electronic Bands vs. Volume 

As-4s 

As-4p 

Ga-4s 

Ga-4p 
a=10.0 Å 

a=8.0 Å 
a=7.0 Å 

a=6.0 Å 
a=5.654 Å 

a=5.3 Å 
a=5.0 Å 

GaAs 

a 
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Source	
   a	
  (Å)	
   Gap	
  (eV)	
  

mBJLDA	
   5.653	
   1.510	
  

mBJLDA	
   5.671	
   1.472	
  

Ioffe	
   5.653	
  (300K)	
   1.424	
  (300K)	
  

Ioffe	
   1.519	
  (0K)	
  

Handbook	
   5.653	
  (300K)	
   1.43	
  (300K)	
  

Handbook	
   1.52	
  (0K)	
  

GaAs: Electronic Structure 

© Materials Design, Inc. 2015 

Exp. data: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/  
                 Handbook on Physical Properties of Semiconductors,  
                 Vol. 2, ed. S. Adachi (Kluwer, Boston 2004) 
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Calculational Parameters 
•  MedeA®-VASP 5.3 
•  mBJLDA functional, spin-orbit relativistic 
•  normal precision, default plane-wave cutoff 
•  reciprocal-space projection, linear tetrahedron method 
•  Δk ≈ 0.2/Å, 11×11×11 k-points, Γ-centered  



GaAs: Electronic Structure 
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Exp.	
  
(0	
  K)	
  

Exp.	
  
(300	
  K)	
  

mBJLDA	
  
(5.653)	
  

mBJLDA	
  
(5.671)	
  

Eg	
   1.52	
   1.42	
   1.50	
   1.47	
  

EL	
   1.78	
   1.71	
   1.73	
   1.70	
  

EX	
   2.00	
   1.90	
   1.96	
   1.96	
  

ESO	
   0.34	
   0.34	
   0.31	
   0.31	
  

MedeA®-VASP 
•  computed band energies in good agreement with 

experimental data 
•  temperature effects (thermal expansion, phonons) 

may induce changes (≈ 0.1 eV)  

 

 

  

Exp. data: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/  
                 Handbook on Physical Properties of Semiconductors,  
                 Vol. 2, ed. S. Adachi (Kluwer, Boston 2004) 



Source	
   a	
  (Å)	
   Gap	
  (eV)	
  

HSE	
   5.655	
   1.15	
  

PBE0	
   5.655	
   1.579	
  

Ioffe	
   5.653	
  (300K)	
   1.424	
  (300K)	
  

Ioffe	
   1.519	
  (0K)	
  

Handbook	
   5.653	
  (300K)	
   1.43	
  (300K)	
  

Handbook	
   1.52	
  (0K)	
  

GaAs: Electronic Structure 
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•  Γ-centered meshes 
•  identical for scf and nlX 

Exp. data: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/  
                 Handbook on Physical Properties of Semiconductors,  
                 Vol. 2, ed. S. Adachi (Kluwer, Boston 2004) 

  HSE underestimates Egap 
Egap depends on lattice constant! 
Egap hardly depends on accuracy, 
pw-cutoff, ♯ bands 

Egap determined by smaller of scf and 
nlX k-spacing 

HSE 

PBE0 



GaAs: MD Simulations 

© Materials Design, Inc. 2015 29 

Ab initio MD at 298 K 
  2×2×2 supercell   

MedeA®-VASP 5.3 
PBEsol functional  
  SO coupling 
  normal precision  
  PW cutoff 282.691 eV 
  real-space projection 
Γ-centered mesh with 
0.3/Å k-point spacing,  
i.e. 2×2×2 k-points 



GaAs: MD Simulations 
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  band gap varies by ≈ 0.1 eV  
  HH-LH and HH-SO splittings vary by ≈ 0.05 eV  
  different splittings of 2nd conduction band 

 

 

 

  



  GaAs: Effective Masses 
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MedeA®-Electronics 
•  computed effective masses in good 

agreement with experimental data  
•  heavy hole mass beyond parabolic 

approximation 

 

 

  

Exp.	
   Exp.	
   MedeA	
  

Electrons	
  

Eff.	
  Mass	
  @Γ	
   0.063	
   0.064	
   0.088	
  

Long.	
  Eff.	
  Mass	
  @L	
   1.9	
   1.9	
   1.16	
  

Trans.	
  Eff.	
  Mass	
  @L	
   0.075	
   0.075	
   0.19	
  

Long.	
  Eff.	
  Mass	
  @X	
   1.9	
   1.3	
   1.01	
  

Trans.	
  Eff.	
  Mass	
  @x	
   0.19	
   0.23	
   0.20	
  

Heavy	
  Hole	
  

Eff.	
  Mass	
   0.51	
   0.50	
   0.64/0.73	
  

Light	
  Hole	
  

Eff.	
  Mass	
   0.082	
   0.082	
   0.098	
  

Split-­‐off	
  band	
  	
  

Eff.	
  Mass	
   0.15	
   0.15-­‐0.18	
   0.206	
  

Exp. data: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/  
                 Handbook on Physical Properties of Semiconductors,  
                 Vol. 2, ed. S. Adachi (Kluwer, Boston 2004) 



GaAs: Effective Masses 
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Heavy Hole Light Hole Split-Off 
Exp. calc Exp. calc Exp. calc 

<001> 0.330 0.314 0.090 0.099 0.154 
- 

0.178 

0.207 

<011> 2.949 0.089 0.208 

<111> 0.780 2.838 0.077 0.084 0.205 

Exp. data: http://www.ioffe.rssi.ru/SVA/NSM/Semicond/  
                 Handbook on Physical Properties of Semiconductors,  
                 Vol. 2, ed. S. Adachi (Kluwer, Boston 2004) 

MedeA®-Electronics 
•  directional effective masses 

in reasonable agreement 
with experimental data 

  



 Phonon Dispersions 
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Graphene 

© Materials Design, Inc. 2015 

  Konstantin Novoselov, Andre Geim  
•  first isolated individual graphene planes in 2004  

•  nobel prize 2010  
34 



Analyze Phonons of Graphene 

Phonon dispersions 

© Materials Design, Inc. 2015 35 



Electrical Conductivity in 
Disordered Materials  

© Materials Design, Inc. 2015 36 



Cu1-xAux: Intermetallic Phases 

© Materials Design, Inc. 2015 

•  wide range of solubility 
•  ordered and disordered phases Cu3Au CuAu3 

•  ordered phases from literature (InfomaticA) and cluster expansion (CE) 
•  disordered phases modeled as quasi-random structure (SQS) 

•  mimic first few correlation functions of perfectly random structures 

CuAu 

ordered cubic phases (InfoMaticA): 

disordered cubic phases (SQS): 

37 



Cu1-xAux: Ordered Structures 

© Materials Design, Inc. 2015 

Cu3Au CuAu3 

ordered tetragonal phases from cluster expansion (CE): 

CuAu 

ordered cubic phases (InfoMaticA): 

Cu9Au Cu3Au CuAu CuAu2 CuAu8 
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MedeA® Electronics  

© Materials Design, Inc. 2015 

  Boltzmann theory: semiclassical theory 
•  electrons follow classical equations of motion 

•  electron velocity/effective mass from first principles 

•  results depend on relaxation time (critical!)   

  implemented in MedeA® Electronics    (including BoltzTraP)  

  calculated properties   
•  electrical conductivity 

•  thermopower (Seebeck coefficient)  

•  thermal conductivity (electronic part)  

•  electronic specific heat  

•  Pauli paramagnetic susceptibility 

•  Hall conductivity  

  results vs. temperature or doping 

39 



Cu1-xAux: Electrical Resistivities 

© Materials Design, Inc. 2015 

•  ordered phases show systematically reduced electrical resistivities 
as compared to disordered alloys 

•  very good agreement of calculated data with experimental findings  

Pecher, Haarmann, Nachr. Chem. 61, 1017 (2013);  
Riedel, Janiak, Anorg. Chem. (de Gruyter, Berlin 2007) 

disordered (SQS) 

ordered (CE) 

ordered (lit.) 

40 



 Thermoelectric Power of Bi2Te3 

41 © Materials Design, Inc. 2015 



 Thermoelectricity 

© Materials Design, Inc. 2015 

Peltier effect  
•  use electric power for heating or 

cooling 

Seebeck effect  
•  convert heat into electric power 

42 



 Promising Candidates 

© Materials Design, Inc. 2015 

Figure of merit:                  

Bi2Te3 

  layered structure 
  narrow-gap semiconductor  
  efficient thermoelectric 

when doped with Sb or Se   

 

 

 

 

 

 

 

 

  

Z = σS2/κ 
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Retrieve structure of Bi2Te3 
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layered rhombohedral 
structure 

  covalent bonding within 
slabs 

  van der Waals bonding 
between slabs  

 

 

 

 

 

 

 

  

  Tools → InfoMaticA, InfoMaticA → Search, Clear 

  Define the search criteria 
•  Formula is Bi2Te3 
•  Structural completeness is Complete  

  Retrieve the relevant crystal structures of Bi2Te3 
•  Select structures ICSD.42546 (hexagonal setting of rhombohedral phase) 
•  Right-click on one selected record → View 
•  Draw bonds: Right-click in the structure window → Edit bonds…, OK 



Optimize Structure 
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  Activate Bi2Te3 structure 

  Job Control → New Job… 
•  Right-click on left area → Clear 
•  Open … → Load the flowchart Bi2Te3-full-optimization.flow  

from the training flowchart folder 
•  Right-click on VASP stage → Edit… 
•  Change DFT exchange-correlation to 

GGA-PBEsol 
•  Ok 
•  Enter as Job title: 

Bi2Te3 full optimization PBEsol+SOI 
•  Run 

 

(Only set up the VASP jobs but do not actually run them!) 



Monitor and load optimized structure 
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layered rhombohedral 
structure 

  covalent bonding within 
slabs 

  van der Waals bonding 
between slabs  

 

 

 

 

 

 

 

  

  Clear MedeA® workbench: Windows → Close all windows 

  Check and analyse results:  
•  Job Control → View and Control Jobs (opens JobServer interface in web 

browser)  
•  Click on Jobs and afterwards on relevant job number of the running jobs 
•  Check the progress of the calculation (indicated by Available Results) 

  Upon completion of jobs load the optimized structures 
•  File → Open… → Previous Calculation 
•  Select the final: record of the relevant job 
•  Insert >>, Ok 



Set up MedeA® Electronics job 

  Activate the optimized tetragonal structure 

  Open Electronics module: Tools → Electronics, Electronics → Run 
 
 
 
 
 
 
 
 
 
 
 
 
 
•  Spacing of k-points: 0.1 1/Ang 
•  select VASP settings 

© Materials Design, Inc. 2015 47 



Submit MedeA® Electronics job 
  In VASP GUI 

•  Restore defaults  
•  Calculation type: Single Point (Calculation panel) 
•  DFT exchange-correlation: GGA-PBEsol (Calculation panel) 
•  Magnetism: Spin-orbit magnetic (Calculation panel) 
•  Spacing of k-points: 0.2 1/Ang (SCF panel) 
•  OK 

  Back in Electronics GUI 
•  Enter Title: (Bi2 Te3)3  (R-3MH setting of R-3m) (Electronics) 
•  Run (Only set up the VASP jobs but do not actually run them!) 

  Check and analyse results:  
•  Job Control → View and Control Jobs (opens JobServer interface in web 

browser)  
•  Click on Jobs and afterwards on relevant job number of the running jobs 
•  Check the progress of the calculation (indicated by Available Results) 

  Display electronic transport properties 
•  Electronics → Electronic Transport 
•  Select record of the relevant job 
•  Insert >>, Ok 
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 Analyze results for Bi2Te3 
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  display results as a function of 
•  Temperature 
•  Chemical Potential  

  select/unselect single curves 

 

 

 

 

 

  

  thermoelectric power depends 
•  strongly non-linear on doping 
•  almost linear on temperature   

 

 

  



 MedeA® Electronics: Bi2Te3 
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  indirect band gap, Eg=0.16eV 

  experiment: Eg≈0.18eV 
(Sehr, Testardi, JPCS 1962) 

 

 

 

 

 

 

  

Huang et al., PRB 77, 125209 (2008) 



 MedeA® Electronics: Bi2Te3 
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  calculated Seebeck coefficient 
•  S ≈ 300 µV/K for  p-type doping 

•  S ≈ 220 µV/K for  n-type doping  

 
 

 

 

  

  experiments (RT) 
•  S ≈ 260 µV/K at  
   4×1018 cm-3 p-type 
•  S ≈ 250 µV/K at  
   7.4×1018 cm-3 n-type 
•  S ≈ 287 µV/K n-type 
 

H.J.Goldsmid, Thermoelectric Refrigeration 
(NY, Plenum 1964)  
J. Tan, Proc. SPIE 5836 (2005) 

 
 
 

  

3×1020 cm-3 300 K 



CuRhO2: Thermopower 
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delafossite structure 

•  rhombohedral lattice 

•  RhO2 sandwiches (t2g/eg-splitting) 

•  linear O-Cu-O bonds (sharp DOS-peaks)  

  semiconductor  

  CuRh1-xMgxO2: thermoelectricity   

 

 

 

 

 

 

 

 

  

Cu 

Rh 

O 
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CuRhO2: Thermopower 
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  good qualitative agreement 
•  positive thermopower for hole doping (0 < x < 1022 el/cm3) 

•  positive slope up to about 1000 K  

experimental data: A. Maignan, VE, C. Martin, S. Kremer, 
R. Frésard, D. Pelloquin, PRB 80, 115103 (2009)  

53 



Thermal Conductivity 
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Si-Ge Alloys: Thermal Conductivity  

  Reducing the lattice thermal conductivity enhances ZT 
  Improved understanding of the effect of composition and processing on 
thermal conductivity allows to tailor materials on the atomic scale 
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System	
   Alloy	
   λ	
  (Wm-­‐1K-­‐1)	
  

Si43Ge	
   random	
   6.87	
  

Si43Ge	
   layered	
   3.71	
  

Si43Ge5	
   layered	
   1.87	
  

κ at 300 K in W/(m·K) 

* Data from Ioffe Institute  

random SiXGe1-X 

layered SiXGe1-X 

Sys.	
  	
   Calc.	
  	
   Expt(*)	
  

Si	
   128	
   130	
  

Ge	
   37	
   58	
  



a-Si/c-Si: Thermal Conductivity 

  Introducing disorder can drastically reduce κ, and increase ZT 
  This can be done without changing the composition of the system 
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  ~6% of amorphous Si is enough to reduce κ by a factor of 20! 
  Thermal anisotropy, the ratio of κin-plane and κout-of-plane: between 4 and 6 
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France-Lanord et al., J. Phys.: Cond. Matt. 26 (2014) 355801 



Summary and Perspectives 

  DFT has become a standard in materials research  

  A vast variety of properties can be routinely calculated 
•  structural, mechanical, thermodynamic, kinetic, electronic, 

optical, magnetic, and transport properties 
  Latest developments 

•  Simulation of alloys: Universal Cluster Expansion 
•  Automated forcefields from quantum mechanical calculations 
•  Automation of simulation protocols (Flowcharts) 
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Better materials with 

better simulations 
 

www.materialsdesign.com 



MedeA® in Practice 
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 MedeA® Software 

© Materials Design, Inc. 2015 

ICSD NIST Crystal Data Computed 

C O M P U T A T I O N   O F   P R O P E R T I E S 

Experimental and Computed Structure and Property Data 

ab initio QM - VASP 

Mechanical        Thermal        Chemical        Kinetic        Electric        Optic        Magnetic 

D A T A B A S E S 

M O D E L I N G   &   A N A L Y S I S 

Pearson Pauling 

Monte Carlo - GIBBS Mol. dynamics - LAMMPS 

Job Server 

Task Servers 

Builders: crystals, defects, interfaces, surfaces, 
molecules, nanostructures, polymers, amorphous 

materials 

Analysis: geometry, band structures  and DOS, 
electron and spin density, potential, Fermi surface, 
phonons, transition states, dynamics trajectories 

Semi-empirical - MOPAC 
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MedeA® Training Setup 

User Interface 

Model creation 
and analysis of results 
 
Local databases  
(experimental and computed) 

Loaded with completed 
results of many 
•  Examples 
•  Structures 
•  Properties 

multiple core processor computers 
for serial and parallel calculations 

Local JobServer 

Local TaskServer 
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Access Structures 

Load Structures  
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Ask JobServer for 
available structures 



Crystal	
  Structure	
  Editor	
  

  Change lattice 
parameters 
  Raise/lower 
symmetry 
  Atom properties 

•  Move 
•  Edit (Replace) 
•  Add 
•  Freeze coordinates 
•  Initial magnetic 

moment 
•  Mass 
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Keyboard Shortcuts 
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       - Z  undo the last action 
       - A  select all atoms in the drawing area 
          clear the atom selection 
           delete all selected atoms 
  R/T/S/Z  press and hold down one of these keys to 

  temporarily swap between the current mode 
  and Rotate/Translate/ Select/Zoom 

            + R/T/Z   R 1°/T 0.1 Å/small Z 
            +           + R/T/Z  R 10°/T 1 Å/big Z 
            + R/T + S   R(→)/T selected atoms 
            + R/T + S   R(↑)/T selected atoms 
        + one of the above  R-axis/T      image plane 



Loading Tools to Menu Bar 
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Le_	
  
click	
  



Flowchart: Complexity Made Simple 
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  Filter & Find 

•  User 

•  Status 

•  Time 

•  Number of 
Jobs to 
display 

•  Start Over 

−  Clean all results 

−  Start from fresh Input files 

•  Restart 

−  Use existing files 

−  Get files from completed tasks or redo missing tasks 

JobServer – Web Interface 
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Retrieve & Analyze Results 
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Contact JobServer for 
available results and data Calls Microsoft Excel macro 

 to create spreadsheet 



Building Tools & Editors 
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Crystal	
  Planes	
  

 File	
  →	
  	
  Open	
  →	
  File	
  from	
  
Disk	
  
•  Browse	
  to	
  MD/Structures/
Elements	
  

•  Load	
  Au.sci	
  ,	
  Ag.sci,	
  Pb.sci,	
  …	
  
 Display	
  (1-­‐11)	
  Miller	
  plane	
  
•  Only	
  for	
  your	
  guidance	
  
•  No	
  relevance	
  in	
  
computa8on	
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Supercell	
  Builder	
  

 Builders	
  →	
  Build	
  Supercells…	
  
 Simple	
  
•  NxMxO	
  box	
  

 Automa8c	
  
•  Equally	
  in	
  all	
  direc8ons	
  
•  In	
  one	
  direc8on	
  only	
  
•  (h,k,l),	
  range	
  
•  …	
  like	
  surface	
  builder	
  
 Custom:	
  	
  
•  display	
  hexagonal	
  crystal	
  in	
  orthorhombic	
  box	
  

•  a’=	
  {2	
  1	
  0	
  }	
  a	
  
•  b’=b	
  
•  c’=c	
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Structures & Databases 
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MedeA® InfoMaticA 

Type Atomic coordinates Site occupancy n 

complete all 1 

disordered over-complete 0 ≤ n ≤ 1 

Missing atoms incomplete 0 ≤ n ≤ 1 

unknown none -- 
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  Information on 
•  Structures 
•  Lattice parameters 
•  Literature Data 

−  Experimental setup 
−  Phase information 

•  Powder pattern 
•  Coordination plots 
•  Pair correlation function 

  Interface to the structure databases 
l  ICSD ICSD (FIZ Karlsruhe, Germany) 
l  Pauling (MPDS Projects, Switzerland) 
l  Pearson (ASM International, USA) 
l  NCD (NIST, USA) 
l  COD (Cryst. Open Database) 

  More thanthan 500'000 records in total 
  Binary Phase Diagrams (Pauling) 
  All records:lattice parameters (a, b, c, α, β, γ) 
  Atomic coordinates depend on structure type  
  Available structure types: 

 



InfoMaticA: Search Criteria 

Open InfoMaticA: Tools → InfoMaticA, InfoMaticA → Search ..., panel Search 
Criteria 

 

Add new 
criterion 

Select more 
criteria 
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InfoMaticA: Search Mask 

Pauling binary 
phase diagrams  

Add/Remove 
properties to table 

Sort 
functions 

Load structures 
into viewer 
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 Surfaces 
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Si(001) Surface 
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•  Define 
−  Orientation 
−  Repeat units 

•  Search 
•  OK 

job #190 



Si(001) Surface 
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  Builders>>Build 
Supercell
  5x5x1 supercell 
  Edit >> Cell 

•  Menu or 
•  Right-click   

  Expand cell: 
•   c=40 Å 

  Don’t move atoms 
job #190 



Surface Termination 
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Move planes to exclude 
atoms 
 
Tilt cell a little bit to see red 
and blue planes 
 
Update symmetry 
for Formula: ( ZrO2) 
 
Impose symmetry?  
Centered P1 moves slab into 
middle of cell (no effect on 
calculations) 

  
Avoid polar surface slabs: 
O termination on top, 
Zr termination on bottom 
 
Finish with OK 



Preparing Surface Atoms 
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Click on periodic 
table icon 
 
Model boundaries: 
In Cell tab check 
Show Cell 
 
Select atom, right-
click 
Atom >> Add Active 
Bond… 
 
Create a periodic 
copy when done 
 



Surface Hydrogenation 
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Hydrogenate adds H to all active 
bonds 
 
You can use any atom or group 
to Passivate 
 
Use the sketch pen to draw 
molecules  
 
Right-click: Selection >> Simple 
Forcefield Minimization 
 
And don’t forget: there is Undo 



    
 

Better materials with 
better simulations 

 

www.materialsdesign.com 

© Materials Design, Inc. 2015 82 


